
Contents for Treasure MathStorm!

To learn how to use Help, choose How to Use Help from the Help menu.

Playing the Game

    The Master of Mischief has covered the mountain with snow and ice, stolen the crown, 
and hidden the elves' treasures.    Find the hidden treasures to win back the crown and melt 
the ice and snow.
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Customization

When you open a customization screen for an activity, it shows the current level of 
math problems in that activity. You can choose a new level at any time.
Each activity has 6 levels of difficulty.    Click on        on the customization 
screen to see how the levels differ.

Your level choices for the Time Igloo, Gold Room, Crystal Cave, and Icy Gate take effect 
immediately.    Your level choices for Snowball Piles and Elf Questions take effect when you 
get to the next mountain path.

As you play, the program will adjust automatically and move you to a harder or easier 
level, depending on your performance.
You have the option of setting an activity to stay at a specific level and not adjust 
automatically.    To do this, click on the "Remain on this level" button on the activity's 
customization screen.
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Customization
As you play, the program will adjust automatically and move you to a harder or easier 
level, depending on your performance.
You have the option of setting an activity to stay at a specific level and not adjust 
automatically.    To do this, click on the "Remain on this level" button on the activity's 
customization screen.



Elf Questions Level Definitions
Practice adding, subtracting, and multiplying.
Level 1 Add single-digit numbers.

Example: 2 + 3 = ?
Level 2 Add single- and double-digit numbers. 

Example: 15 + 3 = ? 
Subtract single-digit numbers. 
Example: 9 - 6 = ?

Level 3 Same as Level 2 except the middle number is missing. 
Example: 6 + ? = 10

Level 4 Add and subtract double-digit numbers less than 100.    
Level 5 Add numbers that total less than 100.    (Regrouping/carrying needed.)    

Multiply to get answers up to 50.
Level 6 Subtract numbers with differences less than 100.    (Regrouping/borrowing 

needed.)    Multiply to get answers up to 100.
 



Snowball Piles Level Definitions
      

Add, subtract, and redistribute snowballs so that piles have the special number.
Level 1 Add snowballs to the piles.
Level 2 Add and subtract snowballs to and from piles. 
Level 3 Collect a few snowballs from one pile and add them to another pile. 
Level 4 Collect many snowballs from one or more piles and add the snowballs to 

another pile. 
Level 5 Collect all of the snowballs from one or more piles to add to other piles.
Level 6 Collect enough snowballs to fill an empty pile.



Time Igloo Level Definitions
      

Practice reading and calculating time on analog and digital clocks.    In levels 1-3, 
match the time on one clock to the time on the other.    In levels 4-6, calculate a time 
earlier or later than the time shown on the analog clock or digital clock.
Level 1 1/2-hour increments.
Level 2 15-minute increments.
Level 3 5-minute increments.
Level 4 Earlier or later-Easy.
Level 5 Earlier or later-Medium.
Level 6 Earlier or later-Hard.



 Gold Room Level Definitions
      

Explore equalities and inequalities by balancing a scale.
Level 1 Start with one weight on one pan.    
Level 2 Start with two weights on one pan.
Level 3 Start with one weight on each pan.
Level 4 Start with a mystery weight-Easy.

(Use all weights, 1-9.)
Level 5 Start with a mystery weight-Medium.

(Use weights 1, 2, 4, and 8.)
Level 6 Start with a mystery weight-Hard.

(Use weights 1, 3, and 9.)



 Crystal Cave Level Definitions
      

Practice identifying and counting groups of 1s, 10s, and 100s.

Level 1 Count groups of 1s.

Level 2 Count groups of 1s and 10s. 

Level 3 Count groups of 1s, 10s, and 100s.

Level 4 Count groups of 1s, 10s, and 100s.    There may be more
than 9 crystals in the 1s place.

Level 5 Count groups of 1s, 10s, and 100s.    There may be more 
than 9 groups of 10 in the 10s place.

 
Level 6 Count groups of 1s, 10s, and 100s.    The groups may be

placed out of order.    



 Icy Gate Level Definitions
      

Recognize mathematical patterns and complete a sequence of numbers.
Level 1 Sequence of numbers increases by 1s.
Level 2 Sequence of numbers increases by 1s or 10s or decreases by 1s.
Level 3 Sequence of numbers increases by 5s or decreases by 10s or 1s.
Level 4 Sequence of numbers increases by 2s or decreases by 5s or 10s.
Level 5 Sequence of numbers increases by 3s or decreases by 5s or 2s.
Level 6 Sequence of numbers increases by 4s or decreases by 3s or 2s.



Sign-In
      

If you are a new player:
Click on New Player, then type your name.    Click on Start Game to start your icy 
adventure.
To continue a saved game:
If your name is already on the Sign-In list, click on your name.    If you can't see your 
name, use the scroll bar to find it or begin typing your name.    (The black highlight will 
automatically move to where your name is located.)    Then click on Start Game.



The Mountain Paths
      

Finding treasures:

Catch an elf who is carrying a scroll     and answer the question correctly. The elf will
give you the special number of snowballs for that mountain path.

Stand by a snowball pile        and add or remove snowballs until the pile has the special 
number of snowballs.
Before you check a snowball pile for a treasure,        be sure you have the right number 
of snowballs.    Each time you check a pile, it costs some money.
Make sure you check all of the piles on each mountain path!

Beware of snowbullies:    
As you move around, beware of snowbullies! 
If a snowbully hits you, you will lose money.    Catch it with your net, duck, or skate 
under it to save your money. 

Moving up the Mountain:
You'll need 4 tools to move up from one mountain path to the next.    Answer questions 
in the different rooms to earn tools, or buy tools in the store.

Adding Treasures to the Treasure Chest:
Find as many treasures as you can on each trip up the mountain.    Each time you reach
the top of the castle, add your treasures to the treasure chest and an elf will give you a
prize.    Your prizes are stored on shelves in the prize room inside the clubhouse.
When the treasure chest is full, the mountain will thaw, and you will be Champion of 
the mountain.
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 Using the Mouse on the Mountain Paths
      

Click on: To:
Walk left or right
Speed skate left or right
Enter or leave a room; move up to the next path
Duck under a snowbully.
Use your net to capture elves and snowbullies
Add or subtract a snowball from a pile
Check a snowball pile

You can also move around by pointing the mouse cursor where you want to go on the 
screen and holding down the mouse button.



 Using the Keyboard on the Mountain Paths
      

Press: To:
    or    

Walk left or right

    
      or      
    

Speed skate left or right

Use your net to capture elves and snowbullies
Check an answer or a snowball pile
Enter or leave a room; add a snowball to a pile; move up to the next path
Subtract a snowball from a pile; duck under a snowbully



Elf Questions
      

Each time you catch an elf, you get a chance to earn money by answering a math 
question.

Enter your answer in the flashing box and then click on the elf        to check your 
answer.

See Also
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 Using the Mouse in Elf Questions
      

Click on: To:

Enter your answer
Erase a number

      or        
Check your answer
Return to the mountain path 



Using the Keyboard in Elf Questions
      

Press: To:
Number keys Type your answer

Erase a number you typed
Check your answer 
Return to the mountain path



 The Store
      

You can buy nets and tools (picks, catapult parts, or ladders) here.
Choose what you want to buy.    Then choose the coins you need to pay the exact price. 
(If you need different coins, put a coin on the counter and click on        to get 
change.)

See Also
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Using the Mouse in the Store
      

Click on: To:
Choose an item to buy
Put a coin down or pick it up

      or    
Finish paying
Get change
Return to the mountain path



Using the Keyboard in the Store
      

Press: To:
      or      

Choose an item to buy
then      

        or      
Put a coin down or pick it up
Finish paying
Get change
Return to the mountain path 



 Time Igloo
      

The storm changed the time on Treasure MathStorm's clocks.

Listen to Timer the Timekeeper's directions, then set

the cuckoo clock        or the digital clock    
    to the correct time.
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Using the Mouse in the Time Igloo
      

Click on: To:
Change the time on the digital clock
Change the time on the cuckoo clock

 or          
Check your answer
Return to the mountain path



Using the Keyboard in the Time Igloo

Press: To:
    or    

Change the time on the digital clock or the cuckoo clock
Check your answer
Return to the mountain path



Gold Room
      

The sudden storm tossed the silver weights onto the scale, making it go out of balance.

Put the gold weights          onto one or both of the pans to make the 
scale balance. 

See Also
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 Using the Mouse in the Gold Room
      

Click on: To:
Pick up a weight

Drop a weight

        or        
Check your answer
Return to the mountain path



Using the Keyboard in the Gold Room
      

Press: To:
Check your answer
Return to the mountain path



Crystal Cave
      

The storm blew the elves' crystals all over Crystal Cave.
The Crystal Count has made piles of 1, 10, and 100 crystals.

 

Tell the Crystal Count how many crystals there are all together. 

See Also
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Using the Mouse in the Crystal Cave
      

Click on: To:

Enter the number of crystals
Erase a number

        or      
Check your answer
Return to the mountain path



Using the Keyboard in the Crystal Cave
      

Press: To:
Number keys Type the number of crystals

Erase a number you typed
Check your answer
Return to the mountain path



Icy Gate
      

Figure out the pass number to enter the gate in front of the castle.

Click on the door              to get a number sequence that has a missing number.    
When you know the missing number (the pass number), enter it and then click on    

 .

See Also
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Using the Mouse at the Icy Gate

Click on: To:

See a number sequence

Enter the missing number
Erase a number

      or      
Check your answer
Return to the mountain path 



Using the Keyboard at the Icy Gate

Press: To:
See a number sequence

Number keys Type the missing number
Erase a number you typed

Check your answer 
Return to the mountain path 





Menu Commands
      

File Menu 
Options 



File Menu
      

Use the File menu to see your rank, start another game, or exit the program.

See Also
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Start Another Game 
Exit 



See Rank
      

See Rank shows your rank in the game.    Your rank is determined by the number of 
treasures you have returned to the castle.



 Start Another Game
      

Choose Start Another Game when you want to start a new game or play an old one.
Your current game will be saved.



Exit
      

Choose Exit to quit the program.
Your game will be saved.



Options
      

The Options menu allows you to turn off or on the new player hints, the music and 
sound effects, or the voice.

See Also
New Player Hints 
Music and Sound 
Voice 



New Player Hints
      

Choose New Player Hints to turn the game messages off or on.    These messages 
help you learn how to play the game.    The messages appear automatically when you 
are ranked as a trainee.



 Music and Sound
      

Choose Music and Sound to turn the program's music and sound off or on.    If you 
want to make the game completely quiet, you must also turn off the voice.    



Voice

Choose Voice to turn the voice off or on.    If you want to make the game completely 
quiet, you must also turn off the music and sound. 
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To learn how to use Help, choose How to Use Help from the Help menu or press the F1 
key.
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